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1 INTRODUCTION 

Before starting: CAEN RFID reader system overview 
Before using this software it is useful to get introduced to the basic concepts of CAEN FID readers. 

A CAEN RFID reader can be seen, in a simplified model, as a box with one or more communication 
interfaces to the host side and one or more communication interfaces to the tag side. The reader receives 
commands coming from the host (a PC or any other controlling device) and it uses the interface to the tag 
(typically one or more antennas) to perform operations on tag itself and then it replies back to the host. 

 

Antennas belonging to the same reader can be grouped in logical groups called “logical sources”or simply 
“sources”. 

CAEN RFID protocol defines up to 4 logical sources, named from “Source_0” to “Source_3”. 

A source is composed by the 2 elements specified below: 

 Antennas:  

CAEN RFID readers can have from 1 to 4 antenna ports according to the model. In case of one 
antenna reader the only available antenna is linked to “Source_0”. In case of four antennas reader, 
the default configuration consists of a single antenna connected to a single source. Therefore 
“Source_0” identifies the first antenna... “Source_3” identifies the fourth antenna. Each antenna can 
be linked to the source in a non-exclusive mode: for example the first antenna can be linked to 
“Source_0” and “Source_3”. 

 A set of standard EPC Class1 Gen2 parameters:  

Q value, Session, Selected, and Target (for more info please refer to the EPC Class 1 Gen 2 
specification document [RD1]). 

 

Remember that all operations on the tags are performed through these logical sources. 
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Installation 
CAEN RFID Easy Controller installation is provided through an auto-installer file called Setup.exe: running 
this, Easy Controller will install on pc. 

Before running, be sure that your pc meets the minimum system requirements: 

 1,1 gigahertz (GHz) or faster processor  

 2 gigabyte (GB) RAM 

 30 MB available hard disk space for installation (administration rights required) 

 Microsoft .NET 4.5.1 runtime or higher 

 Microsoft Windows 7/8/10 

 

To install the software: 

1. Download the CAEN RFID Easy Controller Software from our web site (support  software & 
firmware section). 

2. Double click on the Setup.exe file, click on next:  

 

https://www.caenrfid.com/en/support/software-firmware/
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3. Follow the instructions and then click on Finish: 
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If you choose default value during setup, the files of the EasyController will be placed under Program files in 
a folder named CAEN RFID Easy Controller. 

This folder contains: 

Directory/file name Description 

Base This directory contains information on all supported readers 
and on general options. 

BaseUtils.dll This library helps the Easy Controller to parse and save 
information stored in Base folder. 

CAENRFIDLibrary.dll This is the CAEN RFID .NET library used by the Easy Controller 
to work with reader.  

Note: if you want to develop your own .NET application use 
the appropriate link to our site to download the latest 
version of the .NET library. 

Unins000.dat This file is used by the uninstaller. 

Unins000.exe This is the uninstaller: if you want to uninstall the Easy 
Controller please refer to Uninstalling CAEN RFID Easy 
Controller paragraph, page 9. 

Easy Controller src This folder contains Visual Studio professional projects of the 
Easy controller with its source code. 

Tab. 1.1: CAEN RFID Easy Controller Directories 

 

Uninstalling CAEN RFID Easy Controller 
To uninstall CAEN RFID Easy Controller: 

 Click on Start → All Programs → CAEN RFID Easy Controller → Uninstall CAEN RFID Easy Controller. 
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2 HARDWARE CONNECTION 

Introduction 
A CAEN RFID reader connected to a Windows PC can be controlled using the Easy Controller Software for 
Windows, as illustrated in this manual.  

The connection of the reader to the Windows PC can be done via: 

 Bluetooth  

 USB  

 Ethernet  

Depending on the reader’s model, one or more of the options described above may be supported (for 
detail refer to your reader’s technical information manual). 

For readers that support the activation of different usage profiles, management via the Easy Controller 
Software takes place only with EASY2READ profile active (for detail refer to your reader’s technical 
information manual). 

 

Bluetooth Communication Setup  
If supported by the reader, follow the steps below to connect your Windows PC to the CAEN RFID reader 
using the BT connection and the Easy Controller Software. All the images below were generated using the 
Windows 10 Operating System. 

1. Follow the instructions given in your reader’s technical information manual to select the Bluetooth 
communication interface for the reader. 

2. In your Windows Pc go to Settings  Devices. 

3. Click on Bluetooth & other devices  Add Bluetooth or other device: 
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4. Click on Bluetooth: 

 

5. Select the CAEN RFID reader (in this example the skID R1280I reader with serial number 20400011):  

 

6. The message on the screen “Your device is ready to go!” informs you that the connection is 
established. 

If supported by the reader, the Bluetooth blue LED of the reader turns on. 
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Easy Controller via Bluetooth connection 

Once the Bluetooth connection is established, a virtual COM port is created on the host PC. 

This COM port is used to connect to the reader with the CAEN RFID Easy Controller application. 

Follow the steps below to connect the reader using the Easy Controller for Windows via Bluetooth: 

1. Connect the reader to your PC using the Bluetooth connection as explained in previous paragraph. 

2. Download from the CAEN RFID web site the latest version of the CAEN RFID Easy Controller for 
Windows software and install it (see § Installation page 7). 

3. In your Windows Pc go to Settings  Devices. Click on Bluetooth & other devices  More Bluetooth 
option: 

 

 

https://caenrfid.com/en/support/software-firmware/
https://caenrfid.com/en/support/software-firmware/
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4. Look for the COM port in the Bluetooth Settings (COM 13 in the example below): 

 

5. Launch the CAEN RFID Easy Controller application: 

 

6. On the main application window click on File → Connect; the connection dialog box will appear. 
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7. Select RS232 from the Connection Type combo box and the right COM port number from the RS232 
Port combo box (COM13 in this example): 

 

8. Click on Connect. 

9. To verify if the connection with the reader has been established, check the green dot on the bottom 
left side of the sidebar. Into the READER INFORMATION box you can find information on reader 
model, serial number and firmware release: 
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10. Place tags in front of the reader and click on Start Inventory to see the tag information displayed on 
the main window: 

 

You can disconnect the reader by clicking on File →  Disconnect. 
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USB Communication Setup 
If supported by the reader, the reader can be connected to a PC using the USB cable and it is detected by 
the PC as an emulated serial port. 

Follow the steps below to connect your Windows PC to the CAEN RFID reader using the USB connection 
and the Easy Controller Software. All the images below were generated using the Windows 10 Operating 
System. 

1. Follow the instructions given in your reader’s technical information manual to select the USB 
communication interface for the reader. 

2. Connect the CAEN RFID reader to the PC using the USB cable and then power ON the reader. 

3. The USB interface creates virtual COM port on the host PC that can be used to connect to the reader 
with the CAEN RFID Easy Controller application. 

 

Easy Controller via USB connection 

Once the USB connection is established, a virtual COM port is created on the host PC. 

This COM port is used to connect to the reader with the CAEN RFID Easy Controller Software. 

Follow the steps below to connect the reader using the Easy Controller for Windows via USB: 

1. Download from the CAEN RFID web site the latest version of the CAEN RFID Easy Controller for 
Windows software and install it. 

2. In your Windows Pc go to Settings  System. Open the System properties and click on Device 
Manager. 

3. Look for the COM port in the Device Manager window (COM 12 in the example below): 

 

https://caenrfid.com/en/support/software-firmware/
https://caenrfid.com/en/support/software-firmware/
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4. Launch the CAEN RFID Easy Controller application: 

 

5. On the main application window click on File → Connect; the connection dialog box will appear. 

6. Select RS232 from the Connection Type combo box and the right COM port number from the RS232 
Port combo box (COM12 in this example): 

 

7. Click on Connect. 
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8. To verify if the connection with the reader has been established, check the green dot on the bottom 
left side of the sidebar. Into the READER INFORMATION box you can find information on reader 
model, serial number and firmware release: 

 

9. Place tags in front of the reader and click on Start Inventory to see the tag information displayed on 
the main window: 

 

You can disconnect the reader by clicking on File →  Disconnect. 
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Ethernet Communication Setup 
If supported by the reader, the reader can be connected to a Windows PC using an Ethernet cable.  

Follow the instructions given in your reader’s technical information manual to select the Ethernet 
communication interface for the reader and set the network configuration. 

Now you can use the CAEN RFID Easy Software to control the reader.  

 

Easy Controller via Ethernet connection 

Follow the steps below to connect the reader using the Easy Controller for Windows via Ethernet:  

1. Download from the CAEN RFID web site the latest version of the CAEN RFID Easy Controller for 
Windows software and install it. 

2. Launch the Easy Controller application: 

 

3. On the main screen click on File → Connect. A Connection windows will open. Select the Connection 
Type (TCP/IP Connection) and type the reader IP address into the TCP/IP Address box (in this example 
192.168.0.2). Then click on Connect: 

 

https://caenrfid.com/en/support/software-firmware/
https://caenrfid.com/en/support/software-firmware/
https://caenrfid.com/en/support/software-firmware/


  

HARDWARE CONNECTION- Easy Controller Software - Technical Information Manual 21 

4. To verify if the connection with the reader has been established, check the green dot on the bottom 
left side of the sidebar. Into the READER INFORMATION box you can find information on reader 
model, serial number and firmware release (in this example, Mod. R1290I Hex): 

 

5. Place a tag on the reader, click on start inventory and see the tag information displayed on the main 
window: 

 

 

You can disconnect the reader by clicking on File →  Disconnect. 
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3 QUICK START 

Main window 
Once connected to the reader, on the READER INFORMATION box you can find information on reader 
model, serial number and firmware release. 

On the menu bar you can find four options: 

 File: contains the Connect, Disconnect, Enable Logging and Exit choices 

 Settings: contains the Source Selection and Options choices 

 Tools: contains the I/O management (GPIO) choice 

 About: opens the information dialog showing the Easy Controller Version 

 

 

Fig. 3.1: CAEN RFID Easy Controller Side Bar 

 

The Start Inventory button starts and stops the inventory process and shows the information retrieved 
from the tags in the main window. In the TAGS FOUND text box the number of detected tags is shown. 

After the inventory has started, on the lower half of the main window you can find a table containing the 
following parameters: 

 EPC: EPC code of the inventoried tag (tag ID)  

 L. Source: source of identification 

 Antenna: Antenna of the source that has identified the tag 

 TID: TID of tag, if available (default is TID reading off) 

 RSSI: Received Signal Strength Indicator (as 16 bit signed form) 

 COUNT: number of time the tag has been read  

 TimeStamp: timestamp associated with the time of first identification of tag 
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All the above listed parameters can be displayed or not in the table. 

Using the context menu you can select the ones you want to be displayed in the table (right click with the 
mouse on the table and check/uncheck them). 

Finally at the bottom of the main window you can find a status bar displaying the connection status (green 
dot = connected, red dot = not connected) and the anti-collision algorithm (air protocol) in use. 

During the inventory cycle you can check the following parameters inside the Statistic box: 

 Acquisitions per second (Acq/sec): the number of acquisition cycles per second 

 Tags per second (tags/sec): the number of tags detected per second  

 Efficiency (Efficiency): is the value calculated by a Simple Moving Average algorythm using Acq/sec 
and tags/sec parameters 

 Tot tags (Tags found): maximum number of tags detected for each inventory cycle. 

 

Doing inventory 
To start an inventory, click on Start inventory button.  

By default the reader identifies tags using Source 0 (for further information on sources see § Before 
starting: CAEN RFID reader system overview page 6). 

If you want to add sources click on Settings → Source selection and check the desired sources: 

 

 ShowAntMap option helps the user to get a quick view of the current attached antenna for each source: 

 

Remember that if the reader has one antenna, only Source 0 is available. 

To stop the inventory click on Stop Inventory. If Enable Logging has been previously selected, then the 
inventory results are automatically logged. For logging options, see Logging options section. 

Once click on the Start Inventory button, the statistics are tabbed for source and updated values are shown 
only after about 30 total acquisitions. 

Note: the efficiency and the acquisition speed depend on several factors (antenna type, testing 
environment and parameters settings) and do not represent a reliable index for an exhaustive evaluation 
of the reader performance. 

To disable the clearing of the tags from the listview of the main window in each "Start Inventory", click 
right on the listview header and tick the menu item “clear list” (see § Fig. 3.2: Listview header page 24). 
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Filtering Tags 
Click right on the listview header and access the “Filtering Options”: 

 

Fig. 3.2: Listview header 

 

 

Fig. 3.3: Filtering options window 

In the Filtering Options window, you can create filters for the inventory operations. 

To enable the filtering system, check the "Enable Filtering" on the top. 

The filters are concatenated into a unique condition linked by Boolean operators AND and OR. 

To create a new filter, click on "Add New Filter" on the right and a new line will appear in the box. 

Filter parameters: 

 Subject of the filter: 

 EPC: to filter the EPC bank of a tag 
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 TID: to filter the TID bank of a tag 

 RSSI: to filter RSSI values of a tag 

 Condition of the filter: 

 starting with (EPC and TID): the bank starts with a specific value 

 ending with (EPC and TID): the bank ends with a specific value 

 contains (EPC and TID): the bank contains a specific value 

 not contains (EPC and TID): the bank doesn’t contain a specific value 

 Greater than (RSSI): the RSSI value is greater than a specific value 

 Lesser than (RSSI): the RSSI value is less than a specific value 

 Equal to: the RSSI value is equal to a specific value 

 Values: 

 EPC and TID: hexadecimal string representing bytes (eg " 3A5F") 

 RSSI: number of a valid RSSI (eg "-421 " or -42.1 dBm) 

 Activate the filter: 

 Checked: active filter 

 Unchecked: passive filter 

 Conjunction with the next filter (only for two or more filters): 

 AND: binds the results of the current filter with the next one through the logical AND operator 

 OR: binds the results of the current filter with the next one through the logical OR operator 

To remove a filter, select the filter (check “select all” in the top of the box to remove all the filters) and 
click on “Remove Selected”. 

To confirm the created filters, click on “OK”, otherwise click on “Cancel”. 

 

Operating with tags 
After the inventory has been stopped, you can make some operations on tags that have been identified. 
Right click on the desired tag and the following context menu will appear:  

 

The available operations on tags are: 

 ProgramID 

 Read and Write 

 Lock 

 Kill 

 Copy 
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Copy option copies the EPC string in the Windows clipboard. 

ProgramID 

ProgramID allows you to modify the EPC code of the selected tag. Usually EPC codes are 12 bytes length 
(96 bit). 

In case the EPC bank has been previously locked you will need to input an access password. 

The figure below shows the ProgramID window: 

 ID length is the number of bytes of the new ID to program: 12 bytes is the standard length 

 ID is an hexadecimal string that represents the new ID 

 Password is a hexadecimal string that represents access password; it must be exactly 4 byte long 

 

Note: EPC Class1 Gen2 defines two types of password: “kill password” and “access password”and both are 4 
byte long. If a tag is locked, “access password” is used for all the operations but killing: kill operation must 
be performed using the “kill password”. The two passwords are stored in a reserved bank of tag. 

For tags memory map specification, please refer to EPC Class 1 Gen 2 specification document [RD1]. 

 

Read &Write 

You can quickly read and write information inside the tag using the Read&Write command. 

The Read&Write window shows a part of the tag's memory in a mapped area. 

An example of the mapped area: 
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You can set the read/write options: 

 Memory Bank: a combobox permits to choose the memory bank (RESERVED, EPC, TID, USER) where 
to perform the read/write operation 

 Address (word): here you can specify the start address (word-oriented integer number) for the 
read/write operation 

 Length (word): (only for the read operation) here you can specify the number of words (an integer 
number) you want to read starting from Address 

 Password (Hex): here you can put the access password (hexadecimal characters) 

 

Read operation 

Refer to the precedent paragraph to set the read options (memory bank, address, length, password). 

Then click on the Read button to perform the read operation.  

To stop the reading activity in progress, press on the “Cancel” tab: 
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In case of successful read: 

 

 

A red box indicates an unsuccessful read, the causes could be:  

 the tag is no more under the antenna field 

 inaccessible – bank is read-protected – by a previous lock operation 

 not existing area 
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Write operation 

Refer to the precedent paragraph to set the write options (memory bank, address, length, password). 

As an example, consider the following mapped area: 

 

You can put the value (a word) you want to write directly in the boxes of the mapped area. 

The yellow colour indicates the modified boxes: 

 

Then click on the Write button to perform the write operation.  
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To stop the writing activity in progress, press on the “Cancel” tab: 

 

 

A green box indicates that the writing operation is correctly performed and “Memory written successfully!” 
appears at the bottom of the screen: 
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Instead, a red box indicates that the write operation failed and the "Fail to write some cells. Press Write to 
retry or press Read” appears at the bottom of the screen. 

 

 

Lock 

The memory banks of the tag can be write-protected by using the Lock command. 

 

The Lock window contains the following parameters: 

 Memory Bank: a combobox permits to choose the memory bank or field (kill password field, access 
password field, EPC bank, TID bank, USER bank) where to perform the lock operation.  

 Action: it contains a list of  four lock modes available: 

- ACCESSIBLE: the bank is accessible, no need to provide password to operates on this bank 

- PERMANENT ACCESSIBLE: bank is permanent accessible, and it cannot be locked anymore 

- ACCESSIBLE ON SECURE: bank is accessible only if the password is provided 

- PERMANENT INACCESSIBLE: bank is permanently locked, and cannot be made accessible 
anymore 

 Password (Hex): here you can put the access password (4 bytes in hexadecimal characters) 

Lock button: it performs the lock operation. An error message will appear if some parameter is wrong or 
the selected tag is no more under the antenna field. 

Note: the lock command prevents the lock and write operations on EPC, TID and USER memory bank while 
it prevents read, write and lock operations on the kill password and the access password memory fields 
contained in the RESERVED memory bank as specified by the following table Tab. 3.1: Lock – Action-field 
functionality page 32. 
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pwd-write permalock Description 

0 0 
Associated memory bank is writeable from either the open or secured 
states. 

0 1 
Associated memeory bank is permanently writeable from either the 
open or secured states and may never be locked. 

1 0 
Associated memeory bank is writeable from the secured state but not 
from the open state. 

1 1 Associated memory bank is not writeable from any state. 

pwd-
read/write 

permalock Description 

0 0 
Associated password location is readable and writeable from either the 
open or secured states. 

0 1 
Associated password location is permanently readable and writeable 
from either the open or secured states and may never be locked. 

1 0 
Associated password location is readable and writeable from the 
secured state but not from the open state. 

1 1 
Associated password location is not readable or writeable from any 
state. 

Tab. 3.1: Lock – Action-field functionality 

The ISO-18000-6C (C1G2) standard specifies that each tag manufacturer should locate the kill password in 
the first four byte of the RESERVED memory bank, while the access password should be in the next four 
bytes. The standard also specifies that the kill command will fail immediately in case the kill password is set 
to 0 (0x00000000). 

 

Kill 

You can kill a tag using the Kill command. 

Once selected Kill on the contextual menu the following Kill window will appear: 

 

This window provides a password textbox and a Kill button; type the password (4 bytes in hexadecimal 
format i.e. A013B4F9) in the textbox and press Kill. 

A dialog window will appear asking for a last confirmation. 

Warning: Be aware when a tag is killed it won't work anymore! 

 

Note that according to the ISO-18600C (Gen2) standard, if the kill password is equal to 0 (0x00000000), 
then the tag cannot be terminated. 

 

Information about the Easy Controller 
Information on the CAEN RFID Easy Controller are available clicking on About. 

This window shows the current revision of the .NET library used by Easy Controller. 
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4 EASY CONTROLLER OPTIONS 

Options window 
On the main menu, clicking on Settings → Options, will open the Options window.  
This window has a tree-view on the left site with content in the right side.  
There are three main sections: 

 General 

 Reader Configuration 

 Logical Source Configuration 

These sections will be explained below. 
 

 
Fig. 4.1: General Options Window 
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General section 
The General section deals with identification and logging options. 

Identification 

Identification box contains inventory mode and listview options: 

 Inventory Mode. There are three inventory modes: Single, Continuous and Buffered 

- Single mode performs a single inventory cycle each time the Start Inventory button is clicked 

- Continuous mode performs continuous inventory cycles until Stop Inventory button has been 
clicked. 

By clicking on  button you can access the Continuos Inventory Options window.  
Select the Real Continuous Mode (RCM) to perform continuous mode, i.e., a continuous 
inventory via hardware on the source indicated by the RCM Source parameter. If this mode is 
disabled, the inventory is performed in loop via software by the Easy Controller. 
Inventory on button press can be enabled only in the readers equipped with button and allows 
you to perform the inventory just by pressing the button (for more info, refer to the technical 
specifications of your reader). 

 
Fig. 4.2: Continuos Inventory Options window 

- Buffered mode takes the tags from internal buffer if available (when supported by the reader) 

Note: when the Buffered mode is activated the Start Inventory button change to Download 
Buffer. If the reader you have connected doesn't have an internal buffer, this mode is disabled. 
Please refer to your reader documentation. 

 

 ListView Options. In this area you can operate on the following parameters: 

- Converts EPC to ASCII: converts bytes of EPC in ASCII characters. 

- Either in log?: the EPCs in the log file will show as ASCII characters too. 

- Byte Field View: this groupbox is used to choose the byte field view (useful in case of long 
codes). The hexadecimal data can be grouping in: 

   Byte: single byte 
   Word: 2 bytes 
   Dword: 4 bytes 
   Font: opens a dialog to choose the listview font. 
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Logging options 

Logging Options provides a set of preferences for the logging session: 

 Log filename: it is the file where all the logging informations will be stored: clicking on the button “...” 
will open a dialog where you can choose directory and filename. 

 Log file creation mode: here you can select between three options: 

- Overwrite: at the end of the inventory session, a log file is created overwriting the existing one. 

- Append: at the end of the inventory session, new logged data are appended at the end of the 
existing file. 

- New file: at the end of the inventory session, new logged data will be stored in a new file. The 
name of the file will be created with an progressive number at the end (i.e. if the name for the 
log file is DumpTest.txt and it is stored in C drive, the first log file, with absolute path, will be 
'C:\DumpTest00.txt'). 

 Log Info: here you can select the parameters you want to store on the log file: 

- In the first box you can select EPC, SOURCE, ANTENNA, TID, RSSI, COUNT and TIMESTAMP. 

- In the Separator box you can choose the separation mode: Tab (Tab separated values) or CSV 
(comma separated values) useful for most spreadsheet applications. 

- In the EndLine box you can choose the endline separator: CR or CR+LF. 

- Dummy. Here you can add some extra text information in the file (i.e. a description of a reader 
test). 

In the e-seal mode the inventory operation will show an additional column of the e-seal tag status. This 
mode operates only with e-seals: 

 
 
If Save on Exit is checked all general settings will be saved on exit and they will be maintained for the next 
connection. 



  

EASY CONTROLLER OPTIONS - Easy Controller Software - Technical Information Manual 36 

Reader configuration 
CAEN RFID Readers have some basic configuration parameters. By clicking on Reader Configuration you can 
access to the Power settings and Reader Protocol area. 
 

 
Fig. 4.3: Reader Configuration Window 

 

Power Settings Area 

 Power Input. You can increase or decrease the output power of the reader moving the slider from 0% 
to 100%. Not all values can be accepted by the reader, therefore the reader approximates the 
chosen value to the nearest valid one when releasing the mouse button from the slider. 

 In the power input box you can enable the sweep power mode. The sweeping power is useful in 
testing phase to assess the "hit rating" of a session of inventory. Specify the minimum and maximum 
percentage of power to be applied and the number of steps in which to divide the sweeping. As a 
result, each inventory cycle is repeated as many times as the steps indicated, starting from the 
minimum to the maximum percentage of power. 

 Power output allows you to select the measurement unit (useful in case you want information on 
Conducted Power (mW dbM) or Radiated Power (mWerp). 

 Radiated Power Parameters. In this box you can set two parameters that allow to convert the 
Conducted Power into Radiated Power (*erp and *eirp units): Antenna Gain (expressed for linear – 
dBi - or circular antenna type – dBic) and Cable Loss. 
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Reader Protocol Area 

 Change protocol to allows you to change the communication protocol. 

 
Note: in case of fixed power reader, the slider in the “Power Input” box is disabled. 
 
Note: if your reader has an integrated antenna, the Radiated Power Parameters are disabled and the values 
are automatically set with the integrated antenna values. 
 

Advanced Settings 

 

 Warning: This option is for advanced users only! 

 

 
 

 RF Settings:  

  Regulation: it is not possible to modify the regulation, because the RF settings must match 
the country/region of operating to comply with local laws and regulations. The usage of the 
reader in different countries/regions from the one in which the device has been sold is not 
allowed. 

 Channel: modify the channel number in case of interferences. 

 Enable LBT/FHSS: by default the LBT (Listen before talk) or, depending on the regulation, 
the FHSS (frequency hopping) are enabled. 
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 Test: 

 Link profile: only in case of reading difficulties, you can modify the value of the link profile to 
increase the reading data rate. 

 Ant[0-3] RF Impedance Matching: 

  SWR is the result of the impedance matching operation. 

 Matches on connect: enables the reader impedance automatch (if supported by the reader). 

 

Logical source configuration 
Logical sources concepts are described in paragraph Before starting: CAEN RFID reader system overview 
page 6. 
This section is divided into two parts: 

 Source Configuration 

 Summary 

 

 
Fig. 4.4: Logical Source Configuration Window 
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Source configuration 

To configure a logical source follow the steps below: 

 Select a source from the Source Selection combobox. 

 Check/uncheck the antenna to add/remove it from the selected source.  

The status of the antenna is indicated by colour: 

- Red: bad-connected or broken antenna 

- Yellow: poor signal from antenna 

- Green: well-connected antenna 

 
Press “Refresh Antenna Status” button in case you need to check the antenna status. 
On the Properties (C1G2) area you can select some EPC parameters (Q value, Session, Selected and Target). 
For further details on these parameters, please refer to EPC Class 1 Gen 2 specification document [RD1]. 
Click OK or Apply to change settings. 
 
Note: Q parameter is useful for the optimization of the inventory efficiency: as a rule of thumb, if you have 
to read a huge population of tags you need to select a high value for the Q parameter (7 or higher), 
otherwise you can select a lower value. 
 
Note: if your reader has one antennna connector, only Ant0 (first Antenna) and Source 0 are available.  
 

Summary 

Here you can find the summary of all current sources settings. 
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5 GPIO MANAGEMENT 

GPIO Management Window 
Clicking on Tools → I/O Management, the GPIO settings window will appear: 
 

 
 
This window allows you to configure up to 16 GPIO (the number of enabled GPIO depends on the reader 
model). Direction and value are represented respectively by radiobutton and checkbox (if supported by the 
reader). 
If the direction is set on output value, you can use the checkbox to set the output line value, if the direction 
is set on input value, the checkbox is disabled and its status reflects the input line value. 
You can also find the hexadecimal word values of current settings, useful for programmers. 
The Refresh active settings button reads and shows the current values, deleting all the non-applied changes 
made. 
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Multiplexer Management Window 
The Multiplexer Management Window allows you to configure up to 4 multiplexers simultaneously. 

 
Fig. 5.1: Multiplexer Management Window 

 
The GPIO to be used to drive the multiplexer are set through the parameters A0 and A1. 
If you want to disable a multiplexer on an antenna just uncheck all its RFout. 
Click “OK” to confirm, “Cancel” to cancel the latest changes. 

 

 

 


